OpenEnterprise Desktop Reference Guide (V2.83)
Contents

1 OEDesktop ............................................................................................................................... 1
  1.1 Custom Menu................................................................................................................... 1
  1.2 Alarm View Window ........................................................................................................ 2
  1.3 Signal View Window ........................................................................................................ 2
  1.4 Trend View Window ........................................................................................................ 2
  1.5 OEGraphics Window ....................................................................................................... 3
  1.6 Notes Window ................................................................................................................ 3
  1.7 Alarm Banner Window .................................................................................................... 3
  1.8 OEDesktop File Types ................................................................................................... 3
  1.9 OEDesktop Child Window Types .................................................................................... 4
  1.10 OEDesktop Settings .................................................................................................... 4

2 OEDesktop Interface .......................................................................................................... 4
  2.1 Main Display Area .......................................................................................................... 5
  2.2 Window Tabs .................................................................................................................. 5
  2.3 OEDesktop Menu Bar ................................................................................................... 5
    2.3.1 Desktop Menu .......................................................................................................... 5
       2.3.1.1 New File Action .................................................................................................. 6
       2.3.1.2 Open File Action ............................................................................................... 6
       2.3.1.3 Recent View Files ............................................................................................. 6
       2.3.1.4 Open Desktop Action ....................................................................................... 6
       2.3.1.5 Close Desktop Action ...................................................................................... 6
       2.3.1.6 Save Desktop Action ....................................................................................... 6
       2.3.1.7 Save Desktop As... Action .............................................................................. 7
       2.3.1.8 Recent Desktop Files ....................................................................................... 7
       2.3.1.9 Hiding the Toolbar or Status Bar ..................................................................... 7
       2.3.1.10 Toggle Toolbar ................................................................................................ 7
       2.3.1.11 Toggle Status Bar ............................................................................................ 7
       2.3.1.12 Mode Menu Option ........................................................................................ 7
       2.3.1.13 Print Setup ....................................................................................................... 8
       2.3.1.14 Customize .......................................................................................................... 8
       2.3.1.15 Exit .................................................................................................................... 8
       2.3.1.16 Default Files .................................................................................................... 8
       2.3.1.17 Default Files Dialog ....................................................................................... 8
          2.3.1.17.1 Default File List ........................................................................................ 8
          2.3.1.17.2 Type ........................................................................................................... 8
          2.3.1.17.3 Default File ................................................................................................. 9
          2.3.1.17.4 OK Button ................................................................................................ 9
          2.3.1.17.5 Cancel Button .......................................................................................... 9
          2.3.1.17.6 Help Button ............................................................................................... 9
       2.3.2 File Menu ................................................................................................................ 9
          2.3.2.1 File New ............................................................................................................ 9
          2.3.2.2 File Open ......................................................................................................... 9
          2.3.2.3 File Save Dialog ............................................................................................. 9
          2.3.2.4 File Properties ................................................................................................ 10
          2.3.2.5 Printing a File ................................................................................................ 10
          2.3.2.6 File View ......................................................................................................... 10
2.3.3 Security Menu ........................................................................................................11
  2.3.3.1 Login Dialog ......................................................................................................11
  2.3.3.2 Username .........................................................................................................11
  2.3.3.3 Password ..........................................................................................................11
  2.3.3.4 Change Password Dialog ................................................................................11
  2.3.3.5 OEDesktop Client Status Bar Database Name ..................................................11
  2.3.3.6 OEDesktop Client Status Bar User .................................................................12
  2.3.3.7 Logging in through OEDesktop ......................................................................12
  2.3.3.8 Logging out ..................................................................................................12
  2.3.3.9 OEDesktop Security Options - Login Page ..................................................12
    2.3.3.9.1 Load This File on Login ...........................................................................12
    2.3.3.9.2 Launch the OE Login Client on Logout ..................................................12
    2.3.3.9.3 Load This File on Logout .......................................................................13
    2.3.3.9.4 Auto Logout on OEDesktop Exit ..............................................................13
  2.3.3.10 OEDesktop Security Options - Windows Page .............................................13
    2.3.3.10.1 Protected Windows List ..........................................................................13
    2.3.3.10.2 Security Configuration for Protected Windows .....................................13
    2.3.3.10.3 New Protected Window Dialog ............................................................14
      2.3.3.10.3.1 Protected Window Name .................................................................14
  2.3.4 Window Menu ......................................................................................................14
    2.3.4.1 Arranging Windows ......................................................................................15
    2.3.4.2 Current Open Windows ................................................................................15
  2.3.5 Help Menu ..........................................................................................................15
    2.3.5.1 Help File Access .........................................................................................16
    2.3.5.2 About Box ................................................................................................16
  2.4 Toolbar Overview ...................................................................................................16
    2.4.1 New File Action ............................................................................................16
    2.4.2 Open File Action ............................................................................................16
    2.4.3 Save Current File Action ..............................................................................16
    2.4.4 Print Current Window Action ........................................................................16
    2.4.5 Restore Desktop ............................................................................................16
    2.4.6 Toggle Max Size ............................................................................................16
  2.5 OEDesktop Status Bar ............................................................................................16
    2.5.1 All Alarms .....................................................................................................17
    2.5.2 Uncleared Alarms .........................................................................................17
    2.5.3 Unacknowledged Alarms .............................................................................17
    2.5.4 Acknowledged Alarms ................................................................................17
    2.5.5 Current User ................................................................................................17
    2.5.6 Time ..............................................................................................................17

3 Working with View Files ............................................................................................17
  3.1 New File Dialog ....................................................................................................17
    3.1.1 New File Type List ..........................................................................................18
    3.1.2 Window Name Box .......................................................................................18
    3.1.3 Window Type Selector ...................................................................................18
    3.1.4 More Dialog ................................................................................................18
      3.1.4.1 Use Window Name ...................................................................................19
      3.1.4.2 Window Caption .....................................................................................19
      3.1.4.2.1.1 Window Name ...............................................................................19
3.1.4.2.1.2 Window Caption .............................................................. 19
3.1.4.3 Show Status Bar ................................................................. 20
3.1.4.4 Dock with Title Bar .............................................................. 20
3.1.4.5 Dock with Gripper ............................................................... 20
3.1.4.6 Dock Side ................................................................. 20
3.1.4.7 Resizeable ................................................................. 20
3.1.4.8 Restyleable ................................................................. 21
3.1.4.9 Minimizable ................................................................. 21
3.1.4.10 Maximizable ................................................................. 21
3.1.4.11 Window Zoom State ...................................................... 21
3.1.4.12 Height ................................................................. 21
3.1.4.13 Width ................................................................. 21
3.1.4.14 From Top ................................................................. 21
3.1.4.15 Relative To ................................................................. 21
3.1.4.16 Centre On ................................................................. 21
3.1.4.17 Positional Object List ................................................... 21
3.1.4.17.1 OE Desktop .......................................................... 22
3.1.4.17.2 Windows Desktop .................................................. 22
3.1.4.17.3 Mouse Position ...................................................... 22
3.1.4.18 From Left ................................................................. 22
3.2 Open File Dialog ........................................................................... 22
3.2.1 File Type ........................................................................ 22
3.2.2 File Name ........................................................................ 22
3.2.3 More Dialog ........................................................................ 23
3.2.3.1 Use Window Name ...................................................... 23
3.2.3.2 Window Caption .......................................................... 23
3.2.3.2.1.1 Window Name ...................................................... 23
3.2.3.2.1.2 Window Caption .................................................. 23
3.2.3.3 Show Status Bar .......................................................... 24
3.2.3.4 Dock with Title Bar ...................................................... 24
3.2.3.5 Dock with Gripper ....................................................... 24
3.2.3.6 Dock Side ................................................................. 24
3.2.3.7 Resizeable ................................................................. 24
3.2.3.8 Restyleable ................................................................. 24
3.2.3.9 Minimizable ................................................................. 25
3.2.3.10 Maximizable ............................................................... 25
3.2.3.11 Window Zoom State .................................................. 25
3.2.3.12 Height ................................................................. 25
3.2.3.13 Width ................................................................. 25
3.2.3.14 From Left ................................................................. 25
3.2.3.15 From Top ................................................................. 25
3.2.3.16 Relative To ................................................................. 25
3.2.3.17 Centre On ................................................................. 25
3.2.3.18 Positional Object List .................................................. 25
3.2.3.18.1 OE Desktop .......................................................... 26
3.2.3.18.2 Windows Desktop .................................................. 26
3.2.3.18.3 Mouse Position ...................................................... 26
3.3 File Save Dialog ........................................................................... 26
3.4 Open Desktop Dialog ................................................................. 27
3.5 Save Desktop Dialog ................................................................... 27
4 OEDesktop Configuration

4.1 OEDesktop Properties Dialog

4.1.1 Menu Page

4.1.1.1 Menu Page with Custom Menu

4.1.1.2 Available Menus List

4.1.1.2.1.1 Displaying / Hiding Default Menu Items

4.1.1.2.1.2 Changing the Order of Menu Items

4.1.1.3 Reset

4.1.1.4 Rename Menu

4.1.1.5 Delete Menu

4.1.1.6 OEMenu Editor Dialog

4.1.1.7 New Menu Item Dialog

4.1.1.7.1 New Menu Name

4.1.1.7.2 Display in Empty Desktop

4.1.2 Desktop Page

4.1.2.1 WorkBook Layout with Tabs

4.1.2.2 Full Screen No Title Bar

4.1.2.3 Visible Menu Bar

4.1.3 Active Docs Page

4.1.3.1 Active Docs List

4.1.3.2 All File Types

4.1.3.3 None

4.1.3.4 Reset Active Docs

4.1.4 Window Stacks Page

4.1.4.1 Window Stacks Page

4.1.4.2 Window Stacks List

4.1.4.3 Delete Window Stack Button

4.1.4.4 New Window Stack Dialog

4.1.4.4.1 Window Stack Name

4.1.4.4.2 Window Stack Size

4.1.4.4.3 Window Stack Example

4.1.5 Protected Window Name

4.1.5.1 Protected Windows List

4.1.5.2 Security Configuration for Protected Windows

4.1.5.3 New Protected Window Dialog

4.1.5.3.1 Protected Window Name

4.2 OEDesktop Security Options Dialog - Login Page

4.2.1 Load This File on Login

4.2.2 Launch the OE Login Client on Logout

4.2.3 Load This File on Logout

4.2.4 Auto Logout on OEDesktop Exit

4.2.5 Windows Page

4.2.5.1 Protected Windows List

4.2.5.2 Security Configuration for Protected Windows

4.2.5.3 New Protected Window Dialog

4.2.5.3.1 Protected Window Name

4.3 Multiple OEDesktop Configuration

4.3.1 Operational Restrictions

4.3.2 Functional Restrictions

4.3.3 Opening OEGraphics Displays

4.3.3.1 From the OEDesktop

4.3.3.2 From OEMenus

4.3.3.3 Launch a New OECtrlWindow

4.3.3.4 Switch to Configure Mode

4.3.3.5 Load a Display into the Window
4.3.3.6 The Target ................................................................. 41
4.3.3.7 The File ................................................................. 41

5 OEDesktop Runtime Features ...................................................... 42
  5.1 Starting OEDesktop ....................................................... 43
  5.2 Logging in through OEDesktop ...................................... 44
  5.3 Logging out ................................................................. 44
  5.4 Changing Password ..................................................... 44
  5.5 OEDesktop Focus and the Menu Bar ......................... 45
     5.5.1.1 Standard OEDesktop Menu Bar .................... 45
     5.5.1.2 OEDesktop Menu Bar with OE Graphics Window in Focus ......................................................... 45
  5.6 OEDesktop Window Titles and Tabs ............................... 45
     5.6.1.1 Window Titles .................................................. 45
     5.6.1.2 Window Tabs .................................................. 45
  5.7 Arranging Windows ..................................................... 46
  5.8 Closing a Window ....................................................... 46
  5.9 Hiding the Toolbar or Status Bar .................................. 47
  5.10 Printing a Selected Window ....................................... 47
  5.11 Changing a Window .................................................. 48
  5.12 Window Properties Dialog ........................................ 48
     5.12.1 Window Caption ............................................. 49
        5.12.1.1 Window Name ......................................... 49
        5.12.1.1.2 Window Caption ................................ 49
     5.12.2 Window Styles ................................................ 49
     5.12.3 Window Height Width and Position .................. 49
  5.13 Window Style Context Menu ....................................... 50
     5.13.1 Maximized Windows ...................................... 50
     5.13.2 Docked Windows ........................................... 50
     5.13.3 Floating Windows .......................................... 50
     5.13.4 Docked To .................................................... 50
     5.13.5 MDI Child As ................................................. 51
     5.13.6 MDI (Multiple Document Interface) Windows .... 51
  5.14 Custom Toolbar Icons ................................................. 51
     5.14.1 Toggle Max Size ........................................... 51
     5.14.2 Restore Desktop ........................................... 51

6 Index .................................................................................. 52
1 OEDesktop

The OEDesktop (OE stands for OpenEnterprise), is a container that is used to manage the windows of OEVView components. It's main purpose is to provide a single, homogeneous multi-windowed environment for OpenEnterprise Workstations.

An example of the style of windows management that can be achieved with the OEDesktop can be viewed below. In the example, the OEDesktop is displaying six active Views in both docked and MDI window mode.

1.1 Custom Menu

This is a custom menu which has been added to the OEDesktop menu bar. It filters the Alarm View window according to alarm priority. Custom context menus can also be configured and added to the context menus which every View has.

OEMenus enable the passing of parameters from one View to another, providing the user with exactly the information that they want to see.
1.2 Alarm View Window

This window contains a configured Alarm View file (extension .AC). Alarm View enables alarms or events to be viewed.

Alarms can be acknowledged, suppressed or unsuppressed from the Alarm View window. There is total control over the color coding and appearance of alarms, including flash behaviour, font size and spacing between the alarms.

1.3 Signal View Window

This window contains a configured Signal View file (extension .SGV). The Signal View component works exclusively with Bristol RTUs, and needs OpenBSI to be installed.

It enables signal values, including the Alarm Inhibit, Manual Inhibit, Control Inhibit and Questionable flags to be viewed and changed. It provides a similar interface and functionality to OpenBSI's DataView, but is part of the OpenEnterprise suite of Views, and is run from the OEDesktop.

1.4 Trend View Window
This window contains a configured Trend View file (extension .TVD). Trend View enables both historical and realtime plotting of signal values over a period of time.

Every aspect of the Trend is configurable, including pen color, thickness, background color, axes and timescale.

### 1.5 OEGraphics Window

![OEGraphics Window](image)

This window contains a sample OEGraphics file (extension .GDF). OEGraphics is a human-machine interface (HMI) application for process control.

It is a fully compliant OPC client featuring ActiveX™ and OLE Automation technologies.

### 1.6 Notes Window

![Notes Window](image)

This window contains a configured Notes file (having an .NCD extension). Notes View enables notes to be sent and read across the system.

Notes may be sent to other users of the system or attached to objects on the system for reading, making it easy to disseminate important information.

### 1.7 Alarm Banner Window

![Alarm Banner Window](image)

This 'docked' window contains an Alarm Banner (or Ribbon) file (extension .ABD). The Alarm Ribbon provides visual information on plant areas having alarms.

It also provides alarm statistics for each plant area and the whole system. The Alarm Banner makes it easy to see at a glance which plant area has the highest number of high priority alarms.

### 1.8 OEDesktop File Types

The OEDesktop manages OpenEnterprise View components. It manages three kinds of file types, all of which can be created, opened and edited/configured within the Desktop:

- Registered OpenEnterprise (OE) ActiveX client controls (Alarm-Event View, Alarm Banner, Alarm Print View, Trend View, SQL View, Notes View);
- Ordinary registered ActiveX controls (Calendar Grid);
• Active documents (OEGraphics, Ms Word or Ms Excel).

1.9 OEDesktop Child Window Types

The Desktop displays files in windows of three types:

• Multiple-Document Interface (MDI) windows: The normal Microsoft 'child window', which cannot be moved outside the Parent window (the Desktop).

• Docked windows: These are attached to one side of the main Desktop window.

• Floating windows: Floating windows are relatively independent of the main Desktop window, e.g. they are not part of the tabbed workspace area and can be moved outside the main window frame.

1.10 OEDesktop Settings

There is a key in the OpenEnterprise settings file which enables the user to change various OEDesktop settings.

The values on this key are not set by the installation routine, and therefore must be set by the user, if required. The name of this key is: -

**Key: OpenEnterprise\Tasks\Window Manager**

The values listed below are best created and modified using the Settings Editor, if they are required.

<table>
<thead>
<tr>
<th>Name</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>MultiDesktopEnable</td>
<td>Set the value to 1 to enable multiple configurations and instances of OEDesktop to be run on the same Workstation. See Multiple OEDesktop Configuration for help on using multiple OEDesktops.</td>
</tr>
<tr>
<td>Message Delay*</td>
<td>Set this and the Retry Reply value to Zero in order to prevent the two OLE dialogs (Server Busy and Server Not Responding) from being displayed.</td>
</tr>
<tr>
<td>Retry Reply *</td>
<td>Set this and the Message Delay value to Zero in order to prevent the two OLE dialogs (Server Busy and Server Not Responding) from being displayed.</td>
</tr>
<tr>
<td>Toggle MaxSize MDI</td>
<td>Default value = &quot;Toggle MaxSize MDI&quot;. If this value is present the OE Desktop toolbar will display an extra couple of buttons. One button toggles the selected child window to/from maximum size (filling the whole OE Desktop window area available and hiding the child window title bar). The other restores the OE Desktop to maximum size if it is not currently at maximum screen size. This is an optional value.</td>
</tr>
</tbody>
</table>

2 OEDesktop Interface

This is the OEDesktop with some configured views loaded into their own windows.
2.1 Main Display Area

This is the main display area of the OEDesktop. Windows containing OE Views (i.e. OEAlarm View, OEGraphics, OETrend View etc.) are displayed here.

2.2 Window Tabs

The window tabs enable the user to see at a glance how many windows are currently open and to quickly bring any window to the top for viewing.

2.3 OEDesktop Menu Bar

This is a close up of the OEDesktop menu bar.

2.3.1 Desktop Menu

The Desktop menu primarily enables the user to open, save and close View and OEDesktop files. It also enables the user to access configure mode for individual Views and the configuration pages for the OEDesktop.
2.3.1.1 New File Action

The New File Dialog will be displayed, allowing the user to choose an OEView type, and specify window size and type.

2.3.1.2 Open File Action

The Open File Dialog will be displayed, allowing the user to select a previously saved file to load into the OEDesktop.

2.3.1.3 Recent View Files

This section of the menu displays the last four View files to have been opened within the OEDesktop. If a file is selected, it will be reloaded into the OEDesktop.

2.3.1.4 Open Desktop Action

This option allows the user to reload a previously saved OEDesktop into the current instance. The Open Desktop Dialog will be displayed to enable this.

2.3.1.5 Close Desktop Action

Selection of this option will close the current instance of the OEDesktop. The user will be prompted to save any OEView files that have been in configure mode.

2.3.1.6 Save Desktop Action

The current OEDesktop will be saved. No 'Save Desktop' dialog will be displayed unless this is a new Desktop file, which has no name.
2.3.1.7 Save Desktop As... Action

This option will open the Save Desktop Dialog, enabling the user to select a directory and name for the new OEDesktop.

2.3.1.8 Recent Desktop Files

This drop-down list displays a list of the most current OEDesktop files which have been used. Selection of a file will automatically load that file into the current instance of the OEDesktop.

2.3.1.9 Hiding the Toolbar or Status Bar

Select the Desktop>View menu item and then select either Toolbar or Status Bar to toggle their visibility.

2.3.1.10 Toggle Toolbar

The Desktop toolbar can be toggled in or out of view by selecting this option.

2.3.1.11 Toggle Status Bar

The child window's status bar can be toggled in or out of view by selecting the Status Bar option while the window is in focus.

2.3.1.12 Mode Menu Option

This option allows the user to toggle the whole OEDesktop and all its child windows into Configure or Runtime mode.

All Configuration options are available to the user for the Desktop while it is in Runtime Mode. To change the Desktop mode, select the desired mode from the Desktop/Mode submenu as shown above. If the Desktop contains no child windows, holding down the [Ctrl] +[M] keys together can also change the Desktop mode. The main effect of this is that all current child windows are set to the new Desktop mode. The other significance of the Desktop mode is that it is taken up as the initial mode of a child window. Saving an OEDesktop in Configure Mode will mean that when it is reloaded, it and all its child windows will be in Configure Mode.

Note: The default Desktop mode is Runtime.
2.3.1.13 Print Setup

This option will open the Windows Print Setup dialog for configuring the available printers.

2.3.1.14 Customize

Selection of this option displays the OEDesktop Properties dialog, which enables the user to configure most aspects of the OEDesktop.

2.3.1.15 Exit

This option exits the current instance of OEDesktop. The user will be prompted to save changes.

2.3.1.16 Default Files...

When selected, the Default Files dialog is displayed. This dialog enables the user to define a previously configured View file to be used whenever a New file is required to be configured within the OEDesktop.

2.3.1.17 Default Files Dialog

This dialog enables the user to define a previously configured View file to be used whenever a New file is required to be configured within the OEDesktop. This saves initial work when configuring new View files. Currently only a Trend View default file is supported.

2.3.1.17.1 Default File List

This list contains the OpenEnterprise file types that can be configured to have a default file. Currently only Trend View files (.OED files) are supported.

2.3.1.17.2 Type

This non-editable field displays the file type of the currently selected file from the Default File List.
2.3.1.17.3 Default File

This field displays the currently configured Default File. If no default file is configured it will remain empty. The browse button ([...]) to the right of this field can be used to open a Select File dialog, which enables the user to select the Default File.

2.3.1.17.4 OK Button

When selected, the dialog will close, and any configuration carried out during the current session with the dialog will be saved.

2.3.1.17.5 Cancel Button

When selected the Default Files Dialog will close. Any configuration done during the current session with the dialog will be lost.

2.3.1.17.6 Help Button

Selecting this button will display context sensitive help for the dialog.

2.3.2 File Menu

This menu option is not normally visible unless a new or previously saved OEView file has been opened within the OEDesktop. The menu options act on the currently selected child window.

2.3.2.1 File New

This option loads a new instance of the OEView type contained in the currently selected window. The new OEView instance will replace the file that currently occupies the window with no prompts.

2.3.2.2 File Open

This option from the File Menu Item will open the Windows File Dialog with the file type set to the OEView extension of the currently selected window. The selected file replaces the file currently in the window with no further prompts.

2.3.2.3 File Save Dialog

The Windows Save As... Dialog is displayed when the Save or Save As... option is selected from the OEDesktop File Menu.
It is opened with the file type set according to the currently selected window. The file in the currently selected window is then saved with the name given in the 'File Name' text box. A default name of 'OEVie\view-<n>' is given where n is the number of View files that have been saved during the current session.

File Menu Item

2.3.2.4 File Properties

This option is only available when the currently selected window is placed into Configure Mode. When the option is selected the Property Dialog of the OEView within the window is displayed. This enables the configuration of the OEView files that will be loaded into the OEDesktop.

2.3.2.5 Printing a File

To print a file, select File/Print while the window is in focus. The button on the toolbar has functionality identical to File/Print.

2.3.2.6 File View

This option allows the user to enable or disable the status information from the currently selected window. This information is displayed inside the OEDesktop status bar.

2.3.2.7 File Mode

This option enables the file in the currently selected window to be placed into Configure or Runtime Mode. A tick resides alongside the currently selected option. The currently selected window can also be placed into Configure Mode by pressing the [Ctrl] and [M] keys simultaneously on the computer keyboard. Whilst in Configure Mode the Property Pages for the OEView component can be accessed for configuration.
2.3.3 Security Menu

The Security menu item enables the user to Login to OpenEnterprise and to configure OEDesktop security.

![Security Menu Screenshot]

2.3.3.1 Login Dialog

When Login is selected from the Security menu item, the Login dialog is displayed.

![Login Dialog Screenshot]

2.3.3.2 Username

The user's login name is typed here. The text defaults to upper case.

2.3.3.3 Password

The user's password is typed in here. It is case sensitive, so upper and lower case letters must be exactly reproduced. The password is seen as asterisks.

2.3.3.4 Change Password Dialog

![Change Password Dialog Screenshot]

2.3.3.5 OELogin Client Status Bar Database Name

This is the name of the database to which the Security Server is attempting a connection. The value is found on the following key in the Settings Editor:-
Key: OpenEnterprise\Tasks\OESecurityManager

Value Name: Database

2.3.3.6 OELogin Client Status Bar User

This section of the OELogin Client status bar displays the name of the currently logged in user.

2.3.3.7 Logging in through OEDesktop

The Security menu allows the user to log in, log out, or change their password. The Login... option displays the Login Client dialog box.

2.3.3.8 Logging out

To log out of OpenEnterprise while Desktop is running, select Security>Logout from the Menu Bar. If successful, the userid will disappear from the OEDeskTop status bar.

2.3.3.9 OEDesktop Security Options - Login Page

This dialog is displayed when the Configure option is selected from the Security Menu Item. The OEDesktop Security Options dialog enables the user to configure a different OEDesktop that is presented when a user logs out of OpenEnterprise. It also allows windows with a certain name to be configured as unclosable.

2.3.3.9.1 Load This File on Login

The login screen is a Desktop file (.OED) that will be loaded when a user logs into OpenEnterprise. The small browse button may be selected to display a Select File dialog which enables the user to browse for an OED file. This feature enables the user to configure a standard Desktop which will appear whenever a new user logs into the Desktop, so that windows opened by the previous user are not available. If the 'Load this .oed file:' field is empty, then no change in Desktop file will be made on login change.

2.3.3.9.2 Launch the OE Login Client on Logout

If this option is set, the OE Login Client will be launched when the user logs out of OpenEnterprise.
2.3.3.9.3 Load This File on Logout

The logout screen is an OED file that will be loaded when the current user logs out of OpenEnterprise. It enables a standard, non-logged in Desktop to be configured. If the 'Load this .oed file' field is empty, then no change in the Desktop file will be made on logout.

2.3.3.9.4 Auto Logout on OEDesktop Exit

If this option is set, the current user will be automatically logged out from Open Enterprise when Desktop exits (i.e. by selecting File/Exit). By default, the user will not be logged out when Desktop exits.

2.3.3.10 OEDesktop Security Options - Windows Page

This dialog is displayed when the Configure option is selected from the Security Menu Item. This page enables the user to configure windows having a specific name which may not be closed down once opened within the Desktop. Configuration on this page must be accompanied by creating an Excluded Custom Token entry for users who will not be able to close this window.

2.3.3.10.1 Protected Windows List

This pane displays a list of configured protected windows.

2.3.3.10.2 Security Configuration for Protected Windows

Once configured in OEDesktop, the name of the protected window must then be added to the Excluded list of Custom Tokens for users or groups who will not be able to close the window. This list is accessed from within the Security Configuration tool, available from the OEToolbox.

When a window with the name NOTES is created within the Desktop, it will now not be possible for the designated users to close it.
2.3.3.10.3  New Protected Window Dialog

This dialog enables the user to give a name to a protected window. A Custom Security token will need to be configured with exactly the same name as this window. Users not having access to this token will be unable to close windows having the specified name.

![New Protected Window Dialog](image)

2.3.3.10.3.1  Protected Window Name

Type the name of the protected window in here. There is a further element of configuration necessary using the OESecurity Configuration tool before the protected window is enabled.

Security Configuration for Protected Windows

2.3.4  Window Menu

The Window item contains options that enable the user to select, configure and arrange the windows within the OEDesktop.

![Window Menu](image)

This dialog is displayed when the Window>Properties menu item is selected. The name, size and position of the window can be changed by entering new values in the appropriate boxes and clicking [OK].
2.3.4.1  Arranging Windows

If there are any files displayed in the Desktop, the Menu Bar will include the Window menu item. This has three arrangement submenu items: "Cascade", "Tile" and "Arrange Icons". These commands act on the MDI Child windows only. All three commands arrange icons of minimized windows at the bottom of the workspace area. The first two also arrange normal MDI Child windows within the tabbed workspace area above the icons, at the same time restoring windows that are not minimized to default size.

2.3.4.2  Current Open Windows

The current open windows list enables the user to see at a glance what windows are open within the OEDesktop, and also enables easy selection of any window. The window with the tick next to it is the currently selected window.

2.3.5  Help Menu

The Help Menu item provides access to this Help file and to the OpenEnterprise about box.
2.3.5.1 Help File Access
The Help menu provides access to this Help file.

2.3.5.2 About Box
The About box provides about the OpenEnterprise product as well as contact details.

2.4 Toolbar Overview
The Toolbar contains buttons which enable you to access often used functions with a single click of the mouse.

2.4.1 New File Action
The New File Dialog will be displayed, allowing the user to choose an OEVView type, and specify window size and type.

2.4.2 Open File Action
The Open File Dialog will be displayed, allowing the user to select a previously saved file to load into the OEDesktop.

2.4.3 Save Current File Action
Selecting this will save the file in the currently selected window.

2.4.4 Print Current Window Action
Selection of this icon will print the currently selected window. The Windows print dialog will be displayed.

2.4.5 Restore Desktop
When this icon is selected the Desktop will be Maximized if its size has been altered. To make this icon appear on the toolbar it is necessary to create an entry in the Settings File.

2.4.6 Toggle Max Size
When this icon is selected the active child window will be set to Maximum size. To make this icon appear on the toolbar it is necessary to create an entry in the Settings File.

2.5 OEDesktop Status Bar
The OEDesktop status bar displays useful information about whatever is in the currently selected window within the Desktop, therefore the information displayed varies.

In this example the Alarm View window is selected, so the status bar is displaying information about current alarms.
2.5.1 All Alarms
This section displays the total number of current alarms.

2.5.2 Uncleared Alarms
This section displays the total number of uncleared alarms.

2.5.3 Unacknowledged Alarms
This part of the status bar displays the total number of unacknowledged alarms.

2.5.4 Acknowledged Alarms
The total number of alarms which have been acknowledged is displayed here.

2.5.5 Current User
The name of the currently logged on user is displayed here.

2.5.6 Time
The current time is displayed here.

3 Working with View Files
Both in configuration and runtime mode, it may be necessary to open, close and save View and OEDesktop files.

1. Opening New View Files
2. Opening Previously Saved View Files
3. Saving View Files
4. Opening Previously Saved OEDesktop Files
5. Saving OEDesktop Files

Both in configuration and runtime mode, it may be necessary to open, close and save View and OEDesktop files.

1. Opening New View Files
2. Opening Previously Saved View Files
3. Saving View Files
4. Opening Previously Saved OEDesktop Files
5. Saving OEDesktop Files

3.1 New File Dialog
The New File dialog, obtained by selecting New from the Desktop menu item, enables the user to select an OEVView file type, give the window it will occupy a name, and set certain parameters for the window.
3.1.1 New File Type List

This list displays the OEView file types that may be loaded into the OEDesktop.

3.1.2 Window Name Box

The window may be given a name by typing in this box. If no name is supplied the OEDesktop provides a name based on the number of windows which have been loaded into this instance of OEDesktop since it was started (i.e. "Window_12").

3.1.3 Window Type Selector

The Window type selector provides a list of window types for selection. The options are:

- **MDI Child** - This is a normal window that can only be moved and displayed within the window display area of the OEDesktop. **Note:** It is the only option available if the OEGraphics (or any other Active Document) file type has been selected.

- **Floating** - This type of window can be moved outside of the OEDesktop window. As it passes the edges of the OEDesktop window it will attach itself to the edges to create a 'Docked' window, but it can be dragged outside. A Floating window has no Minimize, Maximize or Restore buttons.

- **Docked** - This type of window is attached to one side of the main OEDesktop window.

3.1.4 More Dialog

The [More>>] button exposes extra window configuration parameters.
3.1.4.1 Use Window Name

If this box is unchecked, then the window name will be determined by what is typed into the Window Caption text box on this dialog.

3.1.4.2 Window Caption

The window's caption can be changed by typing a new one here. It is important to understand the difference between the window's Name and its Caption.

3.1.4.2.1 Window Name

The window Name is used by OpenEnterprise to identify the window. The Window Name is what is specified on the New File Dialog when loading a new View file into the OEDesktop.

A window Name can be used to identify windows when using the OEDesktop's Window Stacks feature or when using a Window Name for the Target file during OEMenus configuration. The window's caption may be configured separately from its name by using the Caption configuration dialog of OEMenus or from the Window Properties Dialog.

3.1.4.2.2 Window Caption
A window's Caption does not identify the window to OpenEnterprise, but can be used to supply information to the user. Once the file is loaded into its window within OEDesktop, the window Name remains the same, but its Caption can be changed.

The caption on the Title Bar defaults to the Window Name, but if the caption is changed, the Window's Title is changed to the caption typed in here. However, the Window's Name remains the same, as can be verified by selecting the window and then the Window menu from the OEDesktop. The name of the currently selected window at the bottom of this menu will agree with the original name of the window, not its current Caption.

When configuring a window's caption from OEMenus, aliases can be incorporated into the window's Title bar. These aliases are then resolved by parameters passed from the Source View.

More Dialog - New File
More Dialog - Open File

3.1.4.3 Show Status Bar
Indicates whether the status bar will be displayed at the bottom of the Child windows.

3.1.4.4 Dock with Title Bar
For a docked window the user can choose whether to display a Title bar. This option is disabled if the Window Type selection was not Docked.

3.1.4.5 Dock with Gripper
For a docked window the user can choose whether it has a gripper bar. This option is disabled if the Window Type selection was not Docked.

3.1.4.6 Dock Side
At creation a docked window can be docked along the entire length of one of the four main window's sides. Docked windows having a title bar or gripper bar can moved once loaded into the OEDesktop by dragging them by the gripper or title bar to another side. Docked windows with no gripper or title bar cannot be moved once loaded into the OEDesktop. Two or more docked windows may share the same side.

3.1.4.7 Resizeable
If selected, the window will be resizable.
3.1.4.8  **Restyleable**

Toggles the pop-up context menu that allows the user to change the window type.

3.1.4.9  **Minimizable**

The window may be minimized. This feature applies only to MDI child windows.

3.1.4.10  **Maximizable**

The window may be maximized. This feature only applies to MDI child windows.

3.1.4.11  **Window Zoom State**

This will determine the initial state of the window. There are 4 options:

- Normal
- Minimized
- Maximized
- Maximum State - creates a window with normal zoom, but sized as large as possible. This option is only relevant with MDI child windows.

3.1.4.12  **Height**

Height in Pixels. Whereas MDI child and floating windows can have height and width set, only one dimension for docked windows can be set; which one depends on which side it is docked to.

3.1.4.13  **Width**

Width in Pixels. Whereas MDI child and floating windows can have height and width set, only one dimension for docked windows can be set; which one depends on which side it is docked to.

3.1.4.14  **From Top**

The number of pixels that the new window will be offset vertically from the origin of the selected Relative To object.

3.1.4.15  **Relative To**

If selected, the top left corner of the new window will be positioned at an offset relative to the positional object selected. The offset is designated by the values in the From Left and From Top fields. The point from which the offset is calculated will either be the top left corner of the OEDesktop, the Windows Desktop or the current mouse position.

3.1.4.16  **Centre On**

If selected, the centre of the new window will be positioned exactly in the centre of the positional object selected, whether that be the OEDesktop or the Windows Desktop. The mouse is not available in the Positional Object List if the Centre On option is selected.

3.1.4.17  **Positional Object List**

Defines the object that will be used as a marker to position the new window. The new window's position will be determined by the selection made from this list and which of the positioning options was selected (i.e. Relative To or Centre On). The possible positional objects are as follows:
3.1.4.17.1 OE Desktop

If the Relative To option is selected, the new window will be placed at the designated offset from the top left corner of the window display area of the OEDesktop window. If the Centre On option is chosen, the new window will be positioned exactly in the centre of the OEDesktop display area.

3.1.4.17.2 Windows Desktop

This is the default point of origin for Floating windows. If the Relative To option is selected, the top left corner of the new window will appear at the designated offset from the Top Left corner of the Windows Desktop. If the Centre On option was selected, the new window will appear in the exact centre of the Windows Desktop. This option is not available for MDI Child type windows.

3.1.4.17.3 Mouse Position

This option is available as a point of origin for both MDI Child and Floating type windows. If the Relative To option is chosen, the top left corner of the new window will appear at the designated offset from the current position of the mouse. If the Centre On option is chosen, the Mouse Position option is not available.

More Dialog - New File

More Dialog - Saved File

3.1.4.18 From Left

The number of pixels that the new window will be offset horizontally from the origin of the selected Relative To object.

3.2 Open File Dialog

The Open File dialog is displayed by selecting Open from the Desktop menu item.

![Open File Dialog](image)

3.2.1 File Type

This is a drop-down list that contains all file types for OpenEnterprise controls. When opening a file, you are required to specify the file type before OpenEnterprise attempts to open it. This is because when the [OK] button is selected, OpenEnterprise will open the directory where files of the selected type were last saved. This enables quicker access to configured files.

3.2.2 File Name

The name of the file may be typed directly in here, or the selection of the browse button to the right of the File Name field invokes the Select File dialog.
3.2.3 More Dialog

The [More>>] button exposes extra window configuration parameters.

3.2.3.1 Use Window Name

If this box is unchecked, then the window name will be determined by what is typed into the Window Caption text box on this dialog.

3.2.3.2 Window Caption

The window's caption can be changed by typing a new one here. It is important to understand the difference between the window's Name and its Caption.

3.2.3.2.1 Window Name

The window Name is used by OpenEnterprise to identify the window. The Window Name is what is specified on the New File Dialog when loading a new View file into the OEDesktop.

A window Name can be used to identify windows when using the OEDesktop's Window Stacks feature or when using a Window Name for the Target file during OEMenus configuration. The window's caption may be configured separately from its name by using the Caption configuration dialog of OEMenus or from the Window Properties Dialog.

3.2.3.2.2 Window Caption
A window’s Caption does not identify the window to OpenEnterprise, but can be used to supply information to the user. Once the file is loaded into its window within OEDesktop, the window Name remains the same, but its Caption can be changed.

The caption on the Title Bar defaults to the Window Name, but if the caption is changed, the Window’s Title is changed to the caption typed in here. However, the Window’s Name remains the same, as can be verified by selecting the window and then the Window menu from the OEDesktop. The name of the currently selected window at the bottom of this menu will agree with the original name of the window, not its current Caption.

When configuring a window’s caption from OEMenus, aliases can be incorporated into the window’s Title bar. These aliases are then resolved by parameters passed from the Source View.

### 3.2.3.3 Show Status Bar

Indicates whether the status bar will be displayed at the bottom of the Child windows.

### 3.2.3.4 Dock with Title Bar

For a docked window the user can choose whether to display a Title bar. This option is disabled if the Window Type selection was not Docked.

### 3.2.3.5 Dock with Gripper

For a docked window the user can choose whether it has a gripper bar. This option is disabled if the Window Type selection was not Docked.

### 3.2.3.6 Dock Side

At creation a docked window can be docked along the entire length of one of the four main windows’ sides. Docked windows having a title bar or gripper bar can moved once loaded into the OEDesktop by dragging them by the gripper or title bar to another side. Docked windows with no gripper or title bar cannot be moved once loaded into the OEDesktop. Two or more docked windows may share the same side.

### 3.2.3.7 Resizeable

If selected, the window will be resizable.

### 3.2.3.8 Restyleable

Toggles the pop-up context menu that allows the user to change the window type.
3.2.3.9 Minimizable

The window may be minimized. This feature applies only to MDI child windows.

3.2.3.10 Maximizable

The window may be maximized. This feature only applies to MDI child windows.

3.2.3.11 Window Zoom State

This will determine the initial state of the window. There are 4 options:

- Normal
- Minimized
- Maximized
- Maximum State - creates a window with normal zoom, but sized as large as possible. This option is only relevant with MDI child windows.

3.2.3.12 Height

Height in Pixels. Whereas MDI child and floating windows can have height and width set, only one dimension for docked windows can be set; which one depends on which side it is docked to.

3.2.3.13 Width

Width in Pixels. Whereas MDI child and floating windows can have height and width set, only one dimension for docked windows can be set; which one depends on which side it is docked to.

3.2.3.14 From Left

The number of pixels that the new window will be offset horizontally from the origin of the selected Relative To object.

3.2.3.15 From Top

The number of pixels that the new window will be offset vertically from the origin of the selected Relative To object.

3.2.3.16 Relative To

If selected, the top left corner of the new window will be positioned at an offset relative to the positional object selected. The offset is designated by the values in the From Left and From Top fields. The point from which the offset is calculated will either be the top left corner of the OEDesktop, the Windows Desktop or the current mouse position.

3.2.3.17 Centre On

If selected, the centre of the new window will be positioned exactly in the centre of the positional object selected, whether that be the OEDesktop or the Windows Desktop. The mouse is not available in the Positional Object List if the Centre On option is selected.

3.2.3.18 Positional Object List

Defines the object that will be used as a marker to position the new window. The new window's position will be determined by the selection made from this list and which of the positioning options was selected (i.e. Relative To or Centre On). The possible positional objects are as follows:
3.2.3.18.1 OE Desktop

If the Relative To option is selected, the new window will be placed at the designated offset from the top left corner of the window display area of the OEDesktop window. If the Centre On option is chosen, the new window will be positioned exactly in the centre of the OEDesktop display area.

3.2.3.18.2 Windows Desktop

This is the default point of origin for Floating windows. If the Relative To option is selected, the top left corner of the new window will appear at the designated offset from the Top Left corner of the Windows Desktop. If the Centre On option was selected, the new window will appear in the exact centre of the Windows Desktop. This option is not available for MDI Child type windows.

3.2.3.18.3 Mouse Position

This option is available as a point of origin for both MDI Child and Floating type windows. If the Relative To option is chosen, the top left corner of the new window will appear at the designated offset from the current position of the mouse. If the Centre On option is chosen, the Mouse Position option is not available.

More Dialog - New File

More Dialog - Saved File

3.3 File Save Dialog

The Windows Save As... Dialog is displayed when the Save or Save As... option is selected from the OEDesktop File Menu.

![Save As Dialog](image)

It is opened with the file type set according to the currently selected window. The file in the currently selected window is then saved with the name given in the 'File Name' text box. A default name of 'OEVie<n>' is given where n is the number of View files that have been saved during the current session.
3.4 Open Desktop Dialog

This dialog is displayed when the Open Desktop option is selected from the Desktop Menu Item. The Open Desktop dialog enables the user to select and load a previously saved OEDesktop into the current instance of OEDesktop.

3.5 Save Desktop Dialog

This dialog is displayed when the Save or Save As... Desktop option is selected from the Desktop Menu Item. The Save Desktop dialog enables the user to save a configured OEDesktop.

4 OEDesktop Configuration

The OEDesktop is configured with dialogs, all of which are accessible from the menu bar. Unlike the Views which go inside the OEDesktop, the OEDesktop itself does not have to be placed into Configuration mode to configure it.

Below are some tasks which may need to be done to configure the OEDesktop for a new application. Each heading is linked to the appropriate topic.

1. Configuring Custom OEMenus for the OEDesktop
2. Configuring the look of the OEDesktop
3. Enabling other Active documents for OEDesktop
4. Creating Window Stacks
5. Configuring a Logged Out OEDesktop
6. Protecting Windows
7. Multiple OEDesktops

4.1 OEDesktop Properties Dialog

This dialog is displayed when the Customize option is selected from the Desktop menu item.

The Menu tab enables the user to configure the menu bar of the OEDesktop, also providing access to the OEMenu Editor for configuration of Custom OEMenus.

4.1.1 Menu Page

This dialog is displayed when the Customize option is selected from the Desktop menu item.

The Menu tab enables the user to configure the menu bar of the OEDesktop, also providing access to the OEMenu Editor for configuration of Custom OEMenus.
4.1.1.1 Menu Page with Custom Menu

Once a new Custom Menu has been added, the [Rename], [Edit] and [Delete] buttons become enabled when the Custom Menu is selected.

4.1.1.2 Available Menus List

4.1.1.2.1.1 Displaying / Hiding Default Menu Items
By default, the File and Window menu items are hidden until a child window is loaded into the Desktop. Selecting a menu item will toggle the checked/unchecked status of the box. A checked box indicates that the menu item is displayed, an unchecked box indicates that the menu item is not seen.

4.1.1.2 Changing the Order of Menu Items
To change the order in which Menu Items appear along the OEDesktop Menu Bar in Runtime, select and drag a Menu Item to its new location on the Desktop Menu Bar while this Property Page is open.

4.1.1.3 Reset
Selecting this button restores the Desktop Menu bar to its default settings. The default setting is shown here, with the File and Window Menu Items not visible. They become available automatically when a child window is loaded into the Desktop.

4.1.1.4 Rename Menu
The button is only enabled when a Custom Menu item is selected, when selection of this button enables the Custom Menu's name to be changed.

4.1.1.5 Delete Menu
This button is only enabled when a Custom Menu is selected from the Available Menus List, when selection of the button will delete the Custom Menu from the list.

4.1.1.6 OEMenu Editor Dialog
Selecting the [Edit] button displays the OEMenu Editor Dialog for configuring the added Custom OEMenu. See the OEMenus Help File for more information on creating Custom OEMenus.

4.1.1.7 New Menu Item Dialog
This dialog enables the user to give the new menu item a name, specify whether to display the item within an empty desktop and to access the OEMenus configuration dialog.

4.1.1.7.1 New Menu Name
Type the name of the new Menu Item into the Name field.

4.1.1.7.2 Display in Empty Desktop
Check this box to display the new Custom menu in an empty Desktop. If unchecked the new Menu Item will not be visible on the Menu Bar until at least one child window is loaded into the Desktop.

4.1.2 Desktop Page
This dialog is displayed when the Customize option is selected from the Desktop menu item. The Desktop Page enables the user to customize the appearance of the main desktop window.
4.1.2.1 WorkBook Layout with Tabs

Default for this option is checked, which means that the tabs will appear at the bottom of each child window. Unchecking this option causes the tabs at the bottom of OE component windows within the Desktop to disappear.

4.1.2.2 Full Screen No Title Bar

Checking this box will, as the name suggests, remove the Title Bar from the Desktop, and will make the Desktop occupy the whole of the screen.

4.1.2.3 Visible Menu Bar

Unchecking this box will result in the Menu Bar at the top of the Desktop being hidden.

4.1.3 Active Docs Page

This dialog is displayed when the Customize option is selected from the Desktop menu item. This Page enables the user to specify which Active Documents may be loaded into the Desktop.
4.1.3.1 Active Docs List

This list displays the Active Document file types that are registered on the host computer. Selecting a file type will ensure that its type is displayed in the New File dialog available file types list.

4.1.3.2 All File Types

Selection of this button will check all of the Active Document types for possible inclusion within the OEDesktop.

4.1.3.3 None

Selection of this button will clear all the boxes and none of the Active Document file types will be available for loading into the OEDesktop.

4.1.3.4 Reset Active Docs

Selecting the [Reset] button resets the settings on this page to the default, which is to have 'Bristol OpenEnterprise Display' only enabled.

4.1.4 Window Stacks Page

4.1.4.1 Window Stacks Page

This dialog is displayed when the Customize option is selected from the OEDesktop menu item. Normally, OEDesktop requires that each window open within it has a unique name, and will replace the file inside a window if the new window name matches one that is already open.

The Window Stacks Page enables the user to specify a window name that can be re-used so that a number of different View files can be opened simultaneously with the same window name.
4.1.4.2 Window Stacks List

This is a list of the user configured Window Stacks. It displays the window name and the number of instances that will be allowed for cyclic reuse.

4.1.4.3 Delete Window Stack Button

Selection of this button will delete the currently selected Window Stack.

4.1.4.4 New Window Stack Dialog

This dialog enables the user to create a 'Window Stack' which allows a specified number of windows with a given name to be loaded into the OEDesktop. Without a Window Stack, OEDesktop replaces the file inside a window if loading a file which has been given a duplicate window name.

4.1.4.4.1 Window Stack Name

The name of the Window Stack should be typed in here.

4.1.4.4.2 Window Stack Size

The size of the Window Stack is typed in here. The size refers to the number of windows that will be allowed to be loaded into the OEDesktop with the given name.
The result of the above configuration may be seen in the example below. There are three windows within the Desktop, all of which are named ALARM LIST.

Click here to see Window Stack Example

### 4.1.4.4.3 Window Stack Example

![Window Stack Example](image)

4.2 OEDesktop Security Options Dialog - Login Page

This dialog is displayed when the Configure option is selected from the Security Menu Item. The OEDesktop Security Options dialog enables the user to configure a different OEDesktop that is presented when a user logs out of OpenEnterprise. It also allows windows with a certain name to be configured as unclosable.
4.2.1 Load This File on Login

The login screen is a Desktop file (.OED) that will be loaded when a user logs into OpenEnterprise. The small browse button may be selected to display a Select File dialog which enables the user to browse for an OED file. This feature enables the user to configure a standard Desktop which will appear whenever a new user logs into the Desktop, so that windows opened by the previous user are not available. If the ‘Load this .oed file:’ field is empty, then no change in Desktop file will be made on login change.

4.2.2 Launch the OE Login Client on Logout

If this option is set, the OE Login Client will be launched when the user logs out of OpenEnterprise.

4.2.3 Load This File on Logout

The logout screen is an OED file that will be loaded when the current user logs out of OpenEnterprise. It enables a standard, non-logged in Desktop to be configured. If the ‘Load this .oed file’ field is empty, then no change in the Desktop file will be made on logout.

4.2.4 Auto Logout on OEDesktop Exit

If this option is set, the current user will be automatically logged out from Open Enterprise when Desktop exits (i.e. by selecting File/Exit). By default, the user will not be logged out when Desktop exits.

4.2.5 Windows Page

This dialog is displayed when the Configure option is selected from the Security Menu Item. This page enables the user to configure windows having a specific name which may not be closed down once opened within the Desktop. Configuration on this page must be accompanied by creating an Excluded Custom Token entry for users who will not be able to close this window.
4.2.5.1 Protected Windows List

This pane displays a list of configured protected windows.

4.2.5.2 Security Configuration for Protected Windows

Once configured in OEDesktop, the name of the protected window must then be added to the Excluded list of Custom Tokens for users or groups who will not be able to close the window. This list is accessed from within the Security Configuration tool, available from the OEToolbox.

When a window with the name NOTES is created within the Desktop, it will now not be possible for the designated users to close it.

4.2.5.3 New Protected Window Dialog

This dialog enables the user to give a name to a protected window. A Custom Security token will need to be configured with exactly the same name as this window. Users not having access to this token will be unable to close windows having the specified name.

4.2.5.3.1 Protected Window Name

Type the name of the protected window in here. There is a further element of configuration necessary using the OESecurity Configuration tool before the protected window is enabled.
4.3 Multiple OEDesktop Configuration

Normally, only one instance of OEDesktop is allowed to run on a single Workstation. However, multiple instances can be enabled by setting the MultipleDesktopEnable value on the OpenEnterprise\Tasks\Window Manager key in the OpenEnterprise settings file. This is done with the Settings Editor.

The following applies to the use of OEGraphics displays when Multiple Desktops are enabled:

- Operational Restrictions
- Functional Restrictions
- Opening OEGraphics files

4.3.1 Operational Restrictions

When running multiple desktop instances, the following operational restrictions must be strictly adhered to:

- Any display that contains OEMenu actions must be launched within an OEControl Display window instead of a Bristol OpenEnterprise Display window.
- Any display that contains embedded OEControls with OEMenu actions must be launched within an OEControl Display window instead of a Bristol OpenEnterprise Display window.
- Any display launched within an OEControl Display window must be saved without VBA. Failure to save without VBA will cause the display to fail to load.
- Any OEMenu action that launches a display, must be configured to launch an OEControl Display window instead of a Bristol OpenEnterprise Display window.

4.3.2 Functional Restrictions

When running multiple desktop instances, the following functionality restrictions apply:

- Any display that contains OEMenu actions cannot contain VBA.
- Any display that contains embedded OpenEnterprise controls with OEMenu actions cannot contain VBA.
- Any display launched by an OEControl Display cannot be edited using Desktop. The display must be opened and edited within GraphWorX.

There are no known restrictions on the files that can be opened within OEDesktop. For example, the same desktop file can be opened within multiple desktop instances concurrently.

4.3.3 Opening OEGraphics Displays

Opening an OEGraphics displays with multiple OEDesktops enabled requires that you adhere to the following procedures, depending on how you are calling the displays -

4.3.3.1 From the OEDesktop

- Launch a new OEControl window
- Switch to configure mode
- Load an OEGraphics display into the window
4.3.3.2 From OEMenus

- The Target File Type
- The Target File

4.3.3.3 Launch a New OEControl Window

When launching a display for use within a multi-desktop environment, the OEControl Display must be used.

Next, you will be required to select a control. Select the Bristol OpenEnterprise control.

Switch to Configure Mode

4.3.3.4 Switch to Configure Mode

You will now be presented with a new window as follows. Currently the window does not contain a display.
In order to load an actual display file, select the display window and change the window mode to Configure.

### 4.3.3.5 Load a Display into the Window

With the window still selected, select the file properties.
This will display a properties dialog with which you can browse for the required display file.

After selecting OK, place the window in Runtime to test the display.

If the following dialog is displayed after selecting OK or Apply, the display has been saved with VBA and cannot be opened by the OE Control Display.

The display window should now be saved with an oex file extension. The saved oex file can then be used as the target for OEMenu actions.
4.3.3.6 The Target

When creating an OEMenu action that results in an OEGraphics display being loaded, the menu action Target must be the OE Control Display.

The Action can be Load File or Load File with Parameters. The latter must be used when the display contains aliases that must be resolved by the menu action.

Select the [Configure...] button to open the Load File or Load File with Parameters dialog to complete the configuration.

4.3.3.7 The File

The Load File must reference an OE Control Display file that was previously created and saved within Desktop. For the Load File with Parameters dialog, parameters can be set up as usual if the target .OEX file contains a display with aliases. For further help on how to use OEMenus, please refer to the OEMenus help file.
5 OEDesktop Runtime Features

As the configured Desktop becomes the HMI environment for an OpenEnterprise SCADA application the actual Runtime use of the OEDesktop will be different for each application. However, there are certain features and actions which will usually be common to every OpenEnterprise application, such as the general layout of the OEDesktop, how the child windows interact with the OEDesktop, logging in and out and so on. Details of these common Runtime features can be viewed by selecting the links from the list below.

1. Starting the OEDesktop
2. OEDesktop Security
   - Logging In
   - Logging Out
   - Changing Password
3. Window Management
• Window Focus
• Window Tabs
• Arranging Windows
• Closing Windows
• Hiding the Toolbar or Status Bar
• Printing the Contents of a Window
• Extra Toolbar Icons
• Changing a Window’s Style - Menu Bar
• Changing a Window’s Style - Context Menu

5.1 Starting OEDesktop

Select the OEDesktop icon from the Start menu as demonstrated below.
5.2 Logging in through OEDesktop

The Security menu allows the user to log in, log out, or change their password. The Login... option displays the Login Client dialog box.

5.3 Logging out

To log out of OpenEnterprise while Desktop is running, select Security>Logout from the Menu Bar. If successful, the userid will disappear from the OEDeskTop status bar.

5.4 Changing Password

The OELoginClient's Change Password dialog may be invoked directly for the current user via the menu item Security/Change Password.
5.5 OEDesktop Focus and the Menu Bar

One characteristic of Active Document file types (e.g., OE Graphics) is that they use extra, application-specific menu commands. Hence the Menu Bar changes according to which OEDesktop child window is in focus.

5.5.1.1 Standard OEDesktop Menu Bar

5.5.1.2 OEDesktop Menu Bar with OE Graphics Window in Focus

5.6 OEDesktop Window Titles and Tabs

5.6.1.1 Window Titles

The name (or if configured, the window caption) of the window in focus is displayed in the Desktop main window title bar. The window in focus is fully visible and its title bar (if it has one) is blue rather than gray.

5.6.1.2 Window Tabs

If an MDI Child window is in focus it has a larger tab than other MDI Child windows, and its tab appears to be on top of the other tabs. Selecting a window tab gives that window the focus.
5.7 Arranging Windows

If there are any files displayed in the Desktop, the Menu Bar will include the Window menu item. This has three arrangement submenu items: "Cascade", "Tile" and "Arrange Icons". These commands act on the MDI Child windows only. All three commands arrange icons of minimized windows at the bottom of the workspace area. The first two also arrange normal MDI Child windows within the tabbed workspace area above the icons, at the same time restoring windows that are not minimized to default size.

5.8 Closing a Window

To close a file and its window, select Window\Close. This will prompt the user to save the file if the window was ever in Configure mode while displaying the file. If the user accepts the save prompt, a prompt for filename will appear if the file is new. The file and window is also closed by clicking the Close Button in the top right hand corner of the window. Another way to close a file is to replace it by selecting its window within OEDesktop and then selecting the File\New or File\Open option from the OEDesktop Menu bar.
5.9 Hiding the Toolbar or Status Bar

Select the Desktop>View menu item and then select either Toolbar or Status Bar to toggle their visibility.

5.10 Printing a Selected Window

A selected window can be printed by selecting the Printer icon from the Toolbar or by selecting the File>Print menu item from the OEDesktop menu bar:
5.11 Changing a Window

Selecting Window/Properties will bring up a Property Page for the window in focus. This enables the size, position and caption of the window to be changed.

A window's style can also be changed by right-clicking the mouse on the title bar of the window to expose the context-menu.

5.12 Window Properties Dialog

This dialog is displayed when the Window>Properties menu item is selected. The name, size and position of the window can be changed by entering new values in the appropriate boxes and clicking [OK].
5.12.1 Window Caption

The window's caption can be changed by typing a new one here. It is important to understand the difference between the window's Name and its Caption.

5.12.1.1.1 Window Name

The window Name is used by OpenEnterprise to identify the window. The Window Name is what is specified on the New File Dialog when loading a new View file into the OEDesktop.

A window Name can be used to identify windows when using the OEDesktop's Window Stacks feature or when using a Window Name for the Target file during OEMenus configuration. The window's caption may be configured separately from its name by using the Caption configuration dialog of OEMenus or from the Window Properties Dialog.

5.12.1.1.2 Window Caption

A window's Caption does not identify the window to OpenEnterprise, but can be used to supply information to the user. Once the file is loaded into its window within OEDesktop, the window Name remains the same, but its Caption can be changed.

The caption on the Title Bar defaults to the Window Name, but if the caption is changed, the Window's Title is changed to the caption typed in here. However, the Window's Name remains the same, as can be verified by selecting the window and then the Window menu from the OEDesktop. The name of the currently selected window at the bottom of this menu will agree with the original name of the window, not its current Caption.

When configuring a window's caption from OEMenus, aliases can be incorporated into the window's Title bar. These aliases are then resolved by parameters passed from the Source View.

5.12.2 Window Styles

These options are disabled because they cannot be changed. They are there for information only.

5.12.3 Window Height Width and Position

The height, width and position of the child window within the OEDesktop window can be changed by editing these fields. Measurements are in pixels.
5.13 Window Style Context Menu

The Style of a window (providing it is not an OEGraphics window) can be changed by right clicking on it's title bar and selecting an option from the window style context menu.

5.13.1 Maximized Windows

In accordance with standard Microsoft MDI Child behaviour, maximisation of an MDI Child window is not a property of that window but a state that affects all MDI Child windows. Minimisation is a property of one window and affects only that window. With maximisation, it's a case of all or none. Creating an MDI Child window maximised or changing it to be maximised changes all MDI Child windows to be maximised. The MDI workspace changes into 'maximized mode'. To toggle back out of this state, change any window back into normal (or minimised) zoom state, or create a new window in normal (or minimised) zoom state.

An alternative to creating a maximized MDI child window, is to create an MDI child window with 'Maximum Size'. This window has normal zoom. It is as large as possible in the MDI child area, and its child window title bar is hidden underneath the main window's toolbar area.

5.13.2 Docked Windows

Docked Windows are attached to one side of the main Desktop window.

5.13.3 Floating Windows

Floating windows are relatively independent of the main Desktop window, e.g. they are not part of the tabbed workspace area and can be moved outside the main window frame.

5.13.4 Docked To...

The Docked To menu option enables the user to specify which side of the main OEDesktop window the docked window will be attached to. Options are:

- Top
- Left
- Bottom
- Right
5.13.5 MDI Child As...

This option allows the user to specify what state the MDI window will adopt. The options are:

- **Minimized** - the window will be minimized along the bottom of the OEDesktop window.
- **Maximized** - the window will be expanded to its maximum possible size within the OEDesktop. Its title bar will be hidden behind the upper frame of the OEDesktop.
- **Restored** - the window will be restored from a minimized or maximized state to its original state.

5.13.6 MDI (Multiple Document Interface) Windows

This is the normal Microsoft 'child window', which cannot be moved outside the Parent window (i.e. the OEDesktop). OEGraphics windows can only be of this type.

5.14 Custom Toolbar Icons

If the Toggle MaxSize registry key setting has been enabled as described in the Registry Settings Topic, these icons will be available for use on the Desktop toolbar.

5.14.1 Toggle Max Size

When this icon is selected the active child window will be set to Maximum size. To make this icon appear on the toolbar it is necessary to create an entry in the Settings File.

5.14.2 Restore Desktop

When this icon is selected the Desktop will be Maximized if its size has been altered. To make this icon appear on the toolbar it is necessary to create an entry in the Settings File.
# 6 Index

### A
- About Box ......................................................... 18
- Acknowledged Alarms ...................................... 19
- Action .................................................................. 9
- Active Docs List ................................................ 34
- All Alarms ........................................................ 19
- All File Types .................................................... 34
- Auto Logout on OEDesktop Exit ........................ 15, 37
- Available Menus List ........................................ 31

### C
- Caption .............................................................. 21, 25, 50
- Close Desktop Action ......................................... 9
- Current Open Windows .................................... 18
- Current User ..................................................... 19
- Customize ........................................................ 10

### D
- Date Time .......................................................... 19
- Delete Menu ..................................................... 32
- Delete Window Stack Button ............................. 35
- Display .............................................................. 32
- Dock .................................................................... 22, 26
- Dock Side .......................................................... 22, 26
- Docked Windows ............................................. 51

### E
- Empty Desktop ................................................... 32
- Exit .................................................................... 11

### F
- File
  - Closing .......................................................... 48
  - Printing .......................................................... 13
- Full Screen No Title Bar ................................... 33

### G
- Gripper .............................................................. 22, 26

### H
- Height .................................................................. 23, 27
- Height Width ...................................................... 50
- Help File Access ............................................... 18
- Help Menu Item ............................................... 18

### L
- Launch .............................................................. 15, 37

### M
- Main Display Area ............................................. 8
- Maximizable ...................................................... 23, 27
- Maximized Windows ....................................... 51
- MDI .................................................................... 52
- Minimizable ...................................................... 23, 26
- Mode ................................................................... 13
- Mode Menu Option ............................................ 10
- Multiple Document Interface ............................ 52

### N
- Name .................................................................. 24
- Name Box .......................................................... 20
- New ..................................................................... 12
- New File Action .................................................. 9, 18
- New File Type List ............................................ 20
- New Menu Name ............................................... 32
- None .................................................................. 34

### O
- OE Login Client ............................................... 15, 37
  - Launch .......................................................... 15, 37
- OEDesktop ....................................................... 45
  - Starting .......................................................... 45
- OEDesktop Child Window Types ....................... 7
- OEDesktop Dialogs .......................................... 29
- OEDesktop File Types ....................................... 6
- OEDesktop Registry Settings ............................ 7
- OEDesktop Runtime Overview ......................... 44
- OELogin Client Status Bar ................................ 14
- OELogin Client Status Bar User ....................... 14
- OEMenu Editor Dialog ..................................... 32
- Open ............................................................... 12
- Open Desktop Action ........................................ 9
- Open Desktop Dialog ....................................... 28
- Open File Action ............................................. 9, 18

### P
- Password .......................................................... 14, 46
DISCLAIMER

Bristol, Inc., Bristol Babcock Ltd, Bristol Canada, BBI SA de CV and the Flow Computer Division, are wholly owned subsidiaries of Emerson Electric Co. doing business as Remote Automation Solutions (“RAS”), a division of Emerson Process Management. ROC, FloBoss, ROCLINK, Bristol, Bristol Babcock, ControlWave, TeleFlow and Helicoid are trademarks of RAS. AMS, PlantWeb and the PlantWeb logo are marks of Emerson Electric Co. The Emerson logo is a trademark and service mark of the Emerson Electric Co. All other marks are property of their respective owners.

The contents of this publication are presented for informational purposes only. While every effort has been made to ensure informational accuracy, they are not to be construed as warranties or guarantees, express or implied, regarding the products or services described herein or their use or applicability. RAS reserves the right to modify or improve the designs or specifications of such products at any time without notice. All sales are governed by RAS’ terms and conditions which are available upon request. RAS does not assume responsibility for the selection, use or maintenance of any product. Responsibility for proper selection, use and maintenance of any RAS product remains solely with the purchaser and end-user.

Engineered and supported by:

Remote Automation Solutions,
Blackpole Road, Worcester, WR3 8YB, UK

Registered office: Meridian East, Leicester, LE19 1UX

Registered in England and Wales, Registration No. 00671801

VAT Reg No. GB 705 353 652